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1. Overview 

The MDT Right of Way Bureau is responsible for the acquisition of land in support of the 
department’s mission of creating and maintaining the state’s highway transportation 
infrastructure. 
 
The program described in this document has been designed to increase the efficiency & accuracy 
of the parcel document publication process and streamline the publication of Right of Way 
acquisition documents. 
 
The MDT Manage ROW Parcel Documents program allows MDT Right-of-Way design staff to 
Manage Creation and Publication of Right-of-Way Parcel for access by MDT Right-of-Way. 
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2. Main Form 

When the program is first started, the user is presented with the "main" form shown below.  This 
is where all actions start. 
 

 
 
The main form has menu options as follows. 
 
Menus 

 
There are four main level menus that are displayed. 
  
There are one or more options that are displayed under each menu item.  The following shows 
the main menu items and the sub-items for each. 
  
File Menu 

Option Description 

Book  

     Load Book 

Allows for selection of an existing ROW parcels book to be 
opened. 

Book  

     Build New Book 

Allows for building a new ROW parcels book. 

Exit Closes the application. 
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Options Menu 

Option Description 

User Options Opens form for editing user's default "Plotter", "District", “Prompt 
Before Making Changes” or “Prompt To Send Email Notifications” 
options settings. 

 
   
Utilities Menu 

Option Description 

View ROW Parcel Docs 
Update Requests 

Opens form displaying the ROW Parcel Documents Update 
Requests in the Request Queue. 

List ROW Parcels Book 
Parcels Conveyance 
Document and Exhibit 
Pages  

Creates text file containing current ROW Parcels Book Parcel 
Conveyance and Exhibit Pages information. 

 
  
Help Menu 

Option Description 

About Manage ROW 
Parcel Documents 

Opens form displaying information about the Manage ROW Parcel 
Documents Application, including Version and Support contact 
information. 

View User's Manual Opens the PDF version of the Manage ROW Parcel Documents 
User's Manual 
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3. General Operations 

3.1 Start Manage ROW Parcel Documents 

Click on the Manage ROW Parcel Docs shortcut (shown below) in the All Programs  MDT 
Engineering Applications program group on your computer to start the MDT Manage ROW 
Parcel Documents program. 
  

 
  
The Manage ROW Parcel Documents main form will be displayed as shown below. 
  

 
 
After the main form completes loading the next steps are to either build a new ROW Parcels book 
(Build New Book) or load an existing ROW Parcels book (Load Book). 
 





 

7 

4. Build a New ROW Parcels Book 

To build a new ROW Parcels book, select the Build New Book button as shown below. 
 

 
 

Alternatively, selecting the File menu  Book sub-item  Build New Book sub-item option will 
start the process of building a new ROW Parcels book. 
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A Build New ROW Parcels Book form will be displayed as shown below. 
 

 
 
The users default district will be selected when the form opens.  For the above example, the 
default district was Missoula.  To build a new book for a project in a different district select the 
desired district option in the Select District Below section at the top of the form. 
 
The existing projects in the Draft Deeds share for the selected district are displayed in the list box 
under the Select Project Directory Below: label, as shown above. 
 
Next, select the desired project for the new book from the list of projects, as shown below. 
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Next, click the Select DMS Directory For Project button to select the DMS Directory for the 
project.  (The DMS directory must be provided by the user in order for the system to be able to 
find the reference files attached to the ROW Exhibit design files.) 
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The Select DMS Directory For Exhibits Reference Files form is displayed, as shown below. 
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The Enter DMS Directory Here  text entry box will be pre-populated with the selected Project 
from the previous form.  A list of existing DMS directories is displayed under the Select DMS 
Directory Below: label.  The DMS directory in the list that is closest to the text entered into the 

Enter DMS Directory Here  text box will be displayed and selected in the list of DMS 
directories.  If not match is found then no selection will be highlighted in the list. 
 
Find and select the DMS Directory for the project in the list.  The selected DMS directory is 
displayed in the text box under the Selected DMS Directory: label. 
 
Once the proper DMS Directory for the project has been selected, select the Okay button to 
continue, as shown below. 
 

 
 
The Build New ROW Parcels Book form will be re-displayed with the selected DMS directory 
for the project displayed, as shown below: 
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Next, select the units for the project in the Select The Project Units Below section at the 
bottom of the form.  In the example above the units are left at the default English value. 
 
Next, select the Add Parcels button as shown below to add parcels to the new book. 
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Next, you will be prompted to select the location and name for the ROW Parcels book file to be 
saved as, as shown below. 
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The File name will be pre-populated with a file name following DMS file naming standards, 
starting with the DMS directory for the project followed by the RO workgroup and the PED (Parcel 
Exhibit and Conveyance Document) class and ending with the ROW Parcels Book file extension 
(.rwpb), as shown above. 
 
After selecting the desired location and file name select the Save button to save the selection and 
continue the Build New Book operations. 
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Next, the Add Parcels To New Book form will be displayed, as shown below. 
 
This form is used to define the parcels for the new book being created. 
 

 
 
To add parcels first select the Select Parcel button, as shown below: 
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A Select Parcel form will be displayed as shown below. 
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Using this form the user can identify the Parcel number by either selecting from the parcels stored 
in the ROW Parcels database or by manually entering the parcel number. 
 
The Get Parcel From Parcels Database option is selected by default.  When this option is 
selected the parcels stored in the ROW Parcels database are displayed in the list below the 
Selected Parcel Below: label, as shown above. 
 
The user can start entering the desired Parcel number to find in the list into the text box next to 
the Enter Parcel to Find In List label and the entered value will be searched for and selected in 
the list, as shown below. 
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The selected parcel number is displayed in the text box under the Selected Parcel label, as 
shown above. 
 
Alternatively, the user can select the Manually Enter Parcel option and enter the Parcel number 
in the text box, as shown below. 
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After selecting the Parcel number select the Okay button to continue, as shown below. 
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The program will then return to the Add Parcels To New Book form with the selected Parcel 
number populated, as shown below. 
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Next, select the parcel description from the dropdown list of available parcel descriptions, as 
shown below. 
 

 
Note that an explanation of the parcel description selected in the dropdown is displayed near the 
dropdown list to help the user in choosing the proper description. 
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After selecting the desired parcel description from the dropdown list the description is displayed in 
the Selected Parcel Description text box, as shown below. 
 

 
 
If desired the Grantor or Grantee name can be entered in the Enter Grantor/Grantee -- >> 
text box shown above.  In this example it is left blank as it is not required.  After setting the 
required Parcel number and Parcel Description the Add New Parcel is enabled. 
 
Next, select the Add New Parcel button to complete saving the new parcel, as shown below. 

 



Build a New ROW Parcels Book 

23 

The new parcel will be added to the book and displayed in the Exiting Parcels list, as shown 
below. 
 

 
 
The user can continue adding new parcels as necessary by following the same steps as outlined 
above (Select Parcel number, Select Parcel Description, enter Grantor\Grantee if desired, select 
Add New Parcel button). 
 
The Other Parcel Description option allows the user to enter a description that does not match 
any of the descriptions in the list.  To enter other descriptions select the Other Parcel Description 
and an Enter Other Description -- >> text box will be displayed for use in entering the other 
parcel description, as shown below. 
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When done adding all of the desired parcels, select the Add Exhibit Pages button to continue 
the Build New Book process, as shown below. 
 

 
 
The Build Exhibits Pages For New Book form will be displayed, as shown below. 
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To add Exhibit pages to a parcel first select the parcel from the dropdown under the Select Book 
Parcel Below label at the top of the form, as shown below. 
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After selecting the parcel, click the Select Exhibit Design File button to select the Exhibit 
design file for the parcel from the Draft Deeds share, as shown below. 
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A Select Exhibit Design File form will be displayed with the path set to the project folder on 
the Draft Deeds share, as shown below. 
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Browse to the desired Exhibit design file and select the file and then select the Open button to 
complete the design file selection, as shown below. 
 

 
 
The selected Exhibit design file is displayed in the text box next to the button, as shown below. 
 

 
Next, select the Sheet Number in the Exhibit design file for the Exhibit page by selecting the 
Sheet Number button on the left hand side of the form, as shown above.  In this example 
Sheet 1 is being selected. 
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After selecting the Sheet Number the selected sheet number button is indicated with an asterisk 
(*) as shown below. 

 
 
Next, click the Save Selected Sheet To Selected Parcel button to save the Exhibit design file 
information for the Exhibit Page, as shown above. 
 

 
The list displaying the Exhibits Pages for Selected Parcel will be updated to display the saved 
information, as shown above. 
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The user can continue adding Exhibits pages from the selected Exhibits design file by selecting 
the Sheet Number for the next Exhibits page and then clicking the Save Selected Sheet To 
Selected Parcel button. 
 
After finishing adding the desired Exhibit pages for the parcel, select another parcel from the 
Select Book Parcel Below dropdown, as shown below. 
 

 
 
Next, add the Exhibits pages for the parcel in the same manner as above. 
 
Continue adding Exhibits pages to the parcels until all Exhibits pages have been added for all 
parcels, as shown below. 
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Next, click the Add Conveyance Documents button to continue the Build New Book process, 
adding Conveyance documents to the parcels.  After clicking the Add Conveyance Documents 
button a Select Conveyance Documents to be Published form will be displayed as shown 
below. 
 

 
 
To add a Conveyance document to a parcel first select the parcel from the dropdown list of 
parcels below the Select Book Parcel Below label at the top of the form, as shown below. 
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Next, click the Select Conveyance Document File button to select the desired file, as shown 
below. 
 

 
 
A Select Conveyance Document File form will be displayed, as shown below. 
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Select the desired Conveyance document file and then click the Open button to continue the 
document selection process, as shown below. 
 

 
 
The program will return to the Select Conveyance Documents to be Published form with the 
selected document file displayed as shown below. 
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Next, click the Save Selected Conveyance Doc To Selected Parcel button, as shown above, 
to save the document file information to the selected parcel. 
 
Continue adding Conveyance documents to the other parcels by selecting the parcels one by one 
and adding the Conveyance document to the parcel. 

 
 
Once done adding the Conveyance documents to the parcels select the Okay button to complete 
the Build New Book process, as shown below. 
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The Build New Book process will be completed with the new book built.  The program will load 
the newly built book, displaying the book information in the main form as shown below. 
 

 
 
This completed the Build New Book process. 
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5. Load an Existing ROW Parcels Book 

To load an existing ROW Parcels book, select the Load Book button as shown below. 
 

 
 

Alternatively, selecting the File menu  Book sub-item  Load Book sub-item option 
will start the process of loading an existing ROW Parcels book. 

 
A Select ROW Parcels Documents Book form will be displayed as shown below. 
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Browse to and select the desired ROW Parcels Book to open, as shown below. 
 

 
 
Click the Open button, as shown above, to continue the Load Book operation. 
 
The program will return to the main form with the selected book loaded, displaying the book 
information on the main form, as shown below. 
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6. View ROW Parcels Book Information 

Once a book is loaded the book information can be viewed in the main form. 
 
The main form (shown below) is organized as follows: 
 

 
The Current Book Information section in the upper left part of the form (surrounded by the 
blue box) displays the Book File, District, Project, DMS Directory and Units for the loaded book 
and contains the buttons for loading a book or building a new book. 
 
The lower part of the form contains a series of Tabs that are selected by clicking on the tab text. 
 
When a book is loaded the Manage Parcel Documents tab (surrounded by the purple box) is 
selected.  The Manage Parcel Documents tab has three main sections as follows: 
 

 The Parcel Information section in the upper left part of the tab (surrounded in red) is 
used for parcel selection and parcel information display and modification operations. 
 

When the book loads the first parcel will automatically be selected in the Select 
Book Parcels Below: dropdown list, as shown above (in this example the first 
parcel (Parcel-1_EASE) has been automatically selected). 
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The status for the selected parcel is displayed in the Parcel Status: text box.  
Possible statuses are blank (parcel has never been published), Published, Un-
Published and Closed.  In the example above the Parcel Status is blank indicating 
that the parcel has never been published. 
 
The Add Parcel(s) button is used to add parcels to the loaded book. 
 
The Edit Parcel button is used to edit the information for the selected parcel.  The 
information that can be edited is the Parcel Number, Parcel Description and/or 
Grantor/Grantee.  Since editing a parcel changes the Parcel ID, a parcel that is 
published or closed cannot be edited.  A published parcel has an existing Parcel 
folder and parcel documents under the District – Project folder on the published 
documents share.  When parcels are published, the conveyance document is 
removed from the Draft Deeds location and only exists in the published parcel doc 
folder.  Un-publishing the parcel returns the conveyance document to its original 
Draft Deeds location with its original file name so that it can be modified and is 
available for re-publication.  Closed parcels cannot be edited as they are no longer 
active. 
 
The Delete Parcel button is used to delete the selected parcel.  Since deleting a 
parcel removes the parcel, a parcel that is published or closed cannot be deleted.  
Published parcels must first be un-published so that the conveyance document is 
returned to its original Draft Deeds location with its original file name and is 
therefore available for modification and/or publication.  Closed parcels cannot be 
deleted as they are no longer active. 

 
 The Selected Parcel Exhibit Pages Information section in the lower part of the tab 

(surrounded in green) is used for exhibit page selection and exhibit page information 
display and modification operations for the selected parcel. 
 

 
 The Selected Parcel Conveyance Document Information section in the upper right 

part of the tab (surrounded in yellow) is used for conveyance document information display 
and modification operations for the selected parcel. 
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7. Add/Edit Parcels Operations 

To add parcel(s) to the current book select the Add Parcel(s) button, as shown below. 
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The Add Parcels To Current Book form will be displayed, as shown below. 
 
This form works the same as the Add Parcels to New Book form shown here. 
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To edit the current parcel select the Edit Parcel button, as shown below. 
 

 
 
An Edit Current Parcel Confirmation form will be displayed, prompting to confirm the edit 
current parcel operation, as shown below. 
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If the Yes button is selected, the Edit Parcel form will be displayed, as shown below. 
 
This form works similar to the Add Parcels to New Book form shown here. 

 
 
The user selects the Parcel Number, Description and optionally the Grantor/Grantee for the 
modified parcel id.  The modified parcel id information is displayed in the Modified Parcel ID: 
text box. 
 
Once the modified parcel id has been identified select the Okay button to complete the Edit 
Parcel operation, saving the changes to the Parcel ID for the parcel and returning to the main 
form with the updated parcel id displayed. 
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To delete the current parcel select the Delete Parcel button, as shown below. 
 

 
 
A Delete Current Parcel Confirmation form will be displayed, prompting to confirm the delete 
current parcel operation, as shown below. 
 

 
 
If the Yes button is selected, the parcel is deleted from the book and the main form is updated 
with the deleted parcel removed. 
 
 





 

51 

8. Modifying Parcel Exhibit Pages 

After selecting a parcel a user can view and/or modify exhibit pages for the parcel using the 
controls in the Selected Parcel Exhibits Information section of the form. 
 
To insert an exhibit page in the current parcel the user can select the Insert After Current 
Page button, as shown below. 
 

 
 
If the “Prompt Before Making Changes” user option is checked the user will be prompted to 
confirm the Insert After Current Page operation, as shown below. 
 

 
 
If the user selects the Yes button, the Insert Page in Exhibits for Current Parcel form will be 
displayed, as shown below. 
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This form works the same as the Build Exhibits Pages For New Book form shown here. 
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The scroll bar or Page number text box can be used to view the exhibit page information for the 
various pages.  To move to a different exhibit page enter the page number in the Page text box 
or use the scroll bar to move to the page.  Once the desired page is selected the exhibit design 
file and sheet in the file are displayed. 
 
The Exhibit design file for the current parcel exhibit page can be changed by selecting the Select 
Exhibit Design File button and selecting the desired Exhibit design file. 
 
The Sheet for the exhibit page in the current parcel can be changed by selecting the Sheet 
Number button. 
 
After making changes to the exhibit design file and/or sheet on the current exhibit page select the 
Save Current Page button to save the changes, as shown below. 
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To delete an exhibit page from a parcel move to the desired page and select the Delete Current 
Page button, as shown below. 
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To reorder the exhibit pages for a parcel select the Reorder Pages button as shown below. 
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The Reorder Parcel “Parcel ID” Exhibits Pages form will be displayed as shown below. 
 

 
 
Right click on the row containing the page to be moved and hold down the mouse button and 
drag the row to the desired new page location and then release the right click button on the 
mouse to drop the row, moving the exhibit sheet to the new page. 
 
When done reordering the pages select the Okay button to save the changes, returning to the 
main form. 
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9. Modifying Parcel Conveyance Document 

After selecting a parcel a user can view and/or modify the conveyance document for the parcel 
using the controls in the Selected Parcel Conveyance Document Information section of the 
form. 
 
To add or change the conveyance document for a parcel the user can select the Select 
Document File button, as shown below. 
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The Select Conveyance Document File form will be displayed, as shown below. 
 

 
 
Browse to and select the desired conveyance document from the Draft Deeds share and then 
select the Open button, as shown below. 
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The program will return to the main form with the selected document file information displayed in 
the Selected Parcel Conveyance Document Information section of the form, as shown 
below. 
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Next, select the Save Document File button, as shown below, to save the selected document 
file information as the conveyance document for the selected parcel. 
 

 
 
A Save Current Parcel Conveyance Document Confirmation form will be displayed, as 
shown below, prompting for confirmation of the save current parcel conveyance document 
operation. 
 

 
 
Select the Yes button to complete the conveyance document save operation. 
 
A Conveyance Document Info Saved confirmation form will be displayed, providing 
notification that the conveyance document information has been saved to the current book, as 
shown below. 
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After selecting the OK button, the program will return to the main form. 
 
To remove the conveyance document for a parcel the user can select the Remove Document 
File button, as shown below. 
 

 
 
A Delete Current Parcel Conveyance Document File Confirmation form will be displayed, 
as shown below, prompting for confirmation of the delete current parcel conveyance document 
file operation. 
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Select the Yes button to complete the conveyance document deletion operation. 
 
A Conveyance Document Info Deleted confirmation form will be displayed, providing 
notification that the conveyance document information has been saved to the current book, as 
shown below. 
 

 
 
After selecting the OK button, the program will return to the main form with the information for 
the current parcel updated to show no conveyance document, as shown below. 
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10. Printing Check Plots 

To user can use the Print Parcel Exhibit Check Plots tab to get check plot prints. 
 
To start the process of getting parcel exhibit check plots first select the Print Parcel Exhibit 
Check Plots tab on the main form, as shown below. 
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The Print Parcel Exhibit Check Plots tab will be displayed, as shown below. 
 

 
 
The steps to perform to print exhibit check plots for parcels is as follows: 
 
First, select the printer for the check plot prints to be printed to using the Select Printer button.   
 
Next, select the parcel(s) to be printed in the list of parcels with exhibit pages under the All 
Parcels With Exhibit Pages In Book: label. 
 
Finally, select the Print Exhibit Check Plots For Selected Parcel(s) button to submit the 
request for the printed exhibit check plots, as shown below. 
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A View ROW Parcel Documents Update Queue Requests form will be displayed, as show 
below. 

 
The request will be processed by the Network Batch Plotters and the plots will be printed to the 
selected printer. 
 
Click the Close button to close the form, returning to the main form. 
 





 

69 

11. Publish Parcel Documents 

Once the parcel documents have been completed and checked, the user can use the Publish 
Parcel Documents tab to publish the parcel document, making them available for Right-of-Way 
staff to access the documents. 
 
To start the process of publishing parcels first select the Publish Parcel Documents tab on the 
main form, as shown below. 
 

 
 
The Publish Parcel Documents tab will be displayed, as shown below. 
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The steps to perform to publish parcels are as follows: 
 
First, select the parcel(s) to be published in the list of un-published parcels under the Un-
Published Parcels: label. 
 
Next, select the Publish Documents For Selected Parcel(s) button to submit the request to 
publish the parcel documents, as shown below. 
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A View ROW Parcel Documents Update Queue Requests form will be displayed, as show 
below. 

 
The request will be processed by the Network Batch Plotters and the Parcel Exhibit plot and PDF 
files will be created and published and the conveyance document will be published. 
 
Click the Close button to close the form. 
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If the “Prompt To Send Email Notifications” option is checked on in the User Options, a Send 
Publication Notification? form will be displayed, prompting to select whether or not to send an 
e-mail notification, as shown below. 
 

 
 
If Yes is selected, a new outlook e-mail message will be initialized with the Subject and body 
containing Parcel Publication notification information, ready for the user to complete and send, as 
shown below. 
 

 
Click the Close button to close the form, returning to the main form. 
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12. Un-Publish Parcel Documents 

After parcel documents have been published it may be necessary to make modifications.  Before 
making modifications the parcels will need to be un-published as the published documents are no 
longer valid and the published conveyance document file must be returned to its original Draft 
Deeds location. 
 
To start the process of un-publishing parcels first select the Un-Publish Parcel Documents tab 
on the main form, as shown below. 
 

 
 
 
The Un-publish Parcel Documents tab will be displayed, as shown below. 
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The steps to perform to un-publish parcels are as follows: 
 
First, select the parcel(s) to be un-published in the list of published parcels under the Published 
Parcels: label. 
 
Next, select the Un-publish Documents For Selected Parcel(s) button to submit the request 
to un-publish the parcel documents, as shown below. 
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A View ROW Parcel Documents Update Queue Requests form will be displayed, as show 
below. 

 
The request will be processed by the Network Batch Plotters and the Parcel Exhibit plot and PDF 
files will be archived and the conveyance document will be archived and returned to the its 
original Draft Deeds location. 
 
Click the Close button to close the form. 
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If the “Prompt To Send Email Notifications” option is checked on in the User Options, a Send Un-
publication Notification? form will be displayed, prompting to select whether or not to send an 
e-mail notification, as shown below. 
 

 
 
If Yes is selected, a new outlook e-mail message will be initialized with the Subject and body 
containing Parcel Un-publication notification information, ready for the user to complete and send, 
as shown below. 
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13. Close Parcel Documents 

After parcel documents have been published for all of the parcels in the project and the project is 
completed the parcel documents will need to be closed. 
 
To start the process of closing parcels first select the Close Project Parcels tab on the main 
form, as shown below. 
 

 
 
The Close Project Parcels tab will be displayed, as shown below. 
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All parcel folders must be published before the project parcels can be closed.  Hence, in the 
example above the Close The Project Parcels button is disabled as two parcels in the project 
are currently un-published. 
 
Once all parcels have been published for a project the Close Project Parcels tab display shows all 
parcels in the Published Parcels: list and the Close the Project Parcel button is enabled, as 
shown below. 
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Select the Close the Project Parcels button to submit the request to close the project parcels, 
as shown below. 
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A View ROW Parcel Documents Update Queue Requests form will be displayed, as show 
below. 

 
The request will be processed by the Network Batch Plotters and the Project Parcels will be 
closed. 
 
Click the Close button to close the form. 
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If the “Prompt To Send Email Notifications” option is checked on in the User Options, a Send 
Close Notification? form will be displayed, prompting to select whether or not to send an e-mail 
notification, as shown below. 
 

 
 
If Yes is selected, a new outlook e-mail message will be initialized with the Subject and body 
containing Project Parcels Closure notification information, ready for the user to complete and 
send, as shown below. 
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14. View Parcel Documents Status Information 

At any time during the Parcel Document processing process users can view the status of all 
parcels using the Parcel Documents Status Information tab. 
 
To start the process of viewing parcel status information first select the Parcel Documents 
Status Information tab on the main form, as shown below. 
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The Parcel Documents Status Information tab will be displayed, as shown below. 
 

 
 
As shown above, for all of the parcels in the book the Parcel ID, number of Exhibit page, 
Conveyance Document File, Status and Date of Status change are displayed. 
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15. Setting or Changing Default User Options 

To set or change the Default Printer or Default District user options select the Options menu  
User Options sub-item, as shown below. 

 
 

 
The User Options form will be displayed, as shown below. 

 
The current Default Printer is displayed in the Default Printer: text box (in this example the 
Default Printer is \\misnt1\mis4pl). 
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The current Default District is shown in the Default District: dropdown list (in this example the 
default district is Missoula). 
 
The current Prompt Before Making Changes and Prompt To Send Email Notifications options are 
also shown on the form.  In this example both the Prompt Before Making Changes and 
Prompt To Send Email Notifications options are selected. 
 
To change the Default Printer select the Select Printer button as shown below. 
 

 
 
Note: Options that are checked are turned on. 
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The Choose From Approved ROW Plotters Listed Below form will be displayed as shown 
below. 
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Next, select the District for the desired printer, as shown below (in this example the Butte (District 
2) option has been selected). 

 
 
Next, select the desired printer from the dropdown list next to the selected district as shown 
below (in this example the \\butnt1\but3pl printer is being selected). 
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After selecting the desired printer, the selected printer will be displayed in the Selected Printer 
text box, as shown below. 

 
 
Next, select the OK button as shown above to complete the default plotter selection process.  The 
form will close and the new default printer will be displayed in the User Options form as shown 
below. 
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To change the Default District select the desired district from the Default District dropdown list, as 
shown below (in this example the Butte district item is being selected form the dropdown). 
 

 
 
After selecting the desired district from the Default District dropdown list the selected item will be 
displayed in the dropdown list, as shown below. 

 
 
To change the Prompt Before Making Changes option click on the item, as shown below. 
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After changing the Prompt Before Making Changes option the changed selection is displayed 
as shown below. 

 
 
To change the Prompt To Send Email Notifications option click on the item, as shown below. 

 
After changing the Prompt To Send Email Notifications option the changed selection is 
displayed as shown below. 
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Select the OK button, as shown below, to complete the Default Printer and/or Default District 
and/or Prompt Before Making Changes and/or Prompt To Send Email Notifications User Options 
selection process. 

 
 
The User Options form will close and the main form will be displayed.  The new user options will 
be used for all future operations. 
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16. Viewing Request Queue Requests 

The ROW Parcel Documents Updates Request Queue can be viewed to check for requests in the 
queue. 
 
To check for requests select the Utilities menu  View ROW Parcel Docs Update Requests 
sub-item, as shown below. 
 

 
 
The View ROW Parcel Documents Update Queue Requests form will be displayed, as shown 
below. 
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The logged in user’s requests are bracketed by asterisks to make it easier to find the user’s 
requests. 
 
Select the Close button to close the form. 
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17. List ROW Parcels Book Parcels Conveyance Document and 

Exhibit Pages Information 

The ROW Parcels Book Parcels Conveyance Document and Exhibit Pages Information can be listed 
to help with working with parcel documents. 
 
To list the ROW Parcels Book parcels conveyance document and exhibit pages information select 

the Utilities menu  List ROW Parcels Book Parcels Conveyance Document and Exhibit 
Pages Information sub-item, as shown below. 
 

 
 
The book information is written to a text file and opened in Notepad, as shown below. 
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The text file is saved in the C:\Dgn folder with the name displayed at the top of the Notepad 
form. 
 

 



 

97 

18. Viewing Information About The Program 

To view information about the program, including Support contact information select the Help 

menu  About Manage ROW Parcel Documents sub-item, as shown below. 
 

 
 
The About Manage ROW Parcel Documents form will be displayed as shown below. 
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The form displays information about the program including the Version number (in this example 
the version information is Version 1.0.0).  The form also displays support contact information in 
the lower right section of the form.  To e-mail a support contact click on the mailto:...... hyperlink 
text, as shown below. 
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A new Outlook e-mail message will be created with the To.. populated with the e-mail address for 
the support contact and the Subject: populated with a program support request subject item, as 
shown below. 
 

 
 
Simply fill out the desired message content and send the message.  The support contact will 
receive the e-mail message and start the process of addressing the support request. 
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19. Viewing The Program User's Manual 

To view a PDF of the program user’s manual select the Help Menu  View Users Manual 
option, as shown below. 

 
 
The PDF version of the Manage ROW Parcel Documents User's Manual will be displayed, as shown 
below. 
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20. Technical Support 

To obtain technical support, contact one of the following: 
 
Amanda Leslie 
Right-of-Way Bureau 
Phone:  406-444-7677 
aleslie@mt.gov 
  
ISD Engineering Support Team 
mdtisdappmainteng@mt.gov 
 

mailto:aleslie@mt.gov?subject=Access%20ROW%20Parcel%20Documents%20Program%20Support%20Request
mailto:mdtisdappmainteng@mt.gov?subject=Access%20ROW%20Parcel%20Documents%20Program%20Support%20Request

